
MITSUBISHI ELECTRIC MITSUBISHI ELECTRIC

MITSUBISHI ELECTRIC EUROPE B.V.

Specifications subject to change without notice

Start-up Manual

MXChange

Automation Project Manager

Automation Project Manager





MXChange v2.1

Automation Project Manager

Start-up Manual

010905
Version A INDUSTRIAL AUTOMATION





About this Manual

The texts, illustrations, diagrams and examples in this manual are only
intended as aids to help explain the functioning, operation, use and
programming of the MXChange integration system for automation

development tools.
Separate manuals are available for automation development tools like GX
IEC Developer, GX Developer, GX Configurator-DP, E-Designer, MX 32

and MX 2000 SCADA.

If you have any questions regarding the installation and operation of the
software described in this manual, please do not hesitate to contact your

sales office or one of your Mitsubishi distribution partners.
You can also obtain information and answers to frequently asked questions

from our Mitsubishi website under
www.mitsubishi-automation.de.

The MXChange software is supplied under a legal license agreement and may only be used
and copied subject to the terms of this License Agreement.

No part of this manual may be reproduced, copied, stored in any kind of
information retrieval system or distributed without the prior express written

consent of MITSUBISHI ELECTRIC.

MITSUBISHI ELECTRIC reserves the right to change the specifications of
its products and/or the contents of this manual at any time and without

prior notice.

The IEC 61131.1 standard cited in this manual is available from the
publishers Beuth Verlag in Berlin (Germany).

 09/2001
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Typographic Conventions

Use of notes

Notes containing important information are clearly identified as follows:

NOTE Note text

Use of examples

Examples containing important information are clearly identified as follows:

Example � Example

�

Numbering in figures and illustrations

Reference numbers in figures and illustrations are shown with white numbers in a black
circle and the corresponding explanations shown beneath the illustrations are identified with
the same numbers, like this:
� � � �

Procedures

In some cases the setup, operation, maintenance and other instructions are explained with
numbered procedures. The individual steps of these procedures are numbered in ascending
order with black numbers in a white circle, and they must be performed in the exact order
shown:

� Text

� Text

� Text

Footnotes in tables

Footnote characters in tables are printed in superscript and the corresponding footnotes
shown beneath the table are identified by the same characters, also in superscript.

If a table contains more than one footnote, they are all listed below the table and numbered
in ascending order with black numbers in a white circle, like this:
� Text
� Text
� Text

Character formatting and orientation aids

Menu names, menu commands, submenu commands, and dialog box options are printed in
boldface type. Examples: The menu item New in the menu Project or the options PLC
interface and Computer Link in the dialog box Transfer-Setup.

Please keep this manual in a place where it is always available for the users.
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1 Introduction

1.1 Software purpose

MXChange is designed to integrate MITSUBISHI ELECTRIC automation development tools
into a single environment which harmonises programming, supervision, network configuration,
and simulation components.

Examples:

� GX IEC Developer
IEC 61131-3 programming and documentation system providing the user with facilities for
structured programming for MELSEC PLC including function blocks

� GX Developer
Easy to use programming software for MELSEC PLC providing extended import/export
functions

� GX Configurator-DP
Visual configuration software package for open networks such as PROFIBUS DP

� MX32 and MX2000 SCADA
Process visualisation and supervisory system

� E-Designer
Visual programming tool for operator terminals

1.2 General features

MXChange provides the following features:

� Simultaneous definition of I/O references in multiple packages and projects

� Automatic transfer of changes of I/O references to other parts of the automation project

� Automatic transfer of GX Configurator-DP POU blocks to the corresponding GX IEC
Developer projects

� Save GX IEC Developer project to MXChange

� Import and export of parts of the MXChange configuration for use with other MXChange
servers

� Import and export in Microsoft Excel compatible format (CSV)

� Simultaneous generation of multiple tags for all projects based on a supplied pattern

� Synchronisation mechanism

� Security mechanism with log in and password

1.3 This manual is a compact guide...

... to use MXChange suitable for experienced users and factory automation programmers.
The manual explains the terms and structural concepts of the software and describes how
to use MXChange including sample projects.
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1.4 If you are not yet familiar with MS Windows ...

... please read the Windows Fundamentals section in the Windows User's Guide or work
through the Windows Tutorial accessible via the Help function in the Windows Start menu.

1.5 If you encounter any problems...

... or if you have questions concerning MXChange or the automation development tools to
be integrated, please first refer to the manuals. Many answers and solutions can also be
found directly in the MXChange context-sensitive online help system, which can always be
accessed by pressing�. Make use of the Index command in the Help menu as well, as this
will often locate the information you need. If you do not find any answers, contact your local
MITSUBISHI ELECTRIC representative or call our European headquarters in Ratingen
directly.
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2 Installation

2.1 System requirements

To install the MXChange software package, your computer has to meet the following
requirements.

2.1.1 Minimum hardware configuration

� Pentium class PC

� 64 MB RAM

� Hard disk with at least 40 MB free space

� CD-ROM drive

� SVGA compatible graphics adapter

� Mouse

2.1.2 Software requirements

The software runs on the following graphical operating systems:

� MS Windows 95 or 98

� MS Windows NT v4.0 with Service Pack 4 or higher

� Installed TCP/IP network protocol (included in MS Windows)
Refer to the MS Windows manuals or online help for the installation of the TCP/IP network
protocol.

2.2 Copyright

NOTE MXChange is protected by copyright. By operating the distribution disks package you
automatically accept terms and conditions of the Licence Agreement. You are permitted to
make only one single copy of the original distribution disks for your own backup and
archiving purposes
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2.3 Software installation

2.3.1 MXChange software setup

The MXChange software package includes the following programs:

� 32-bit MXChange server for MS Windows 95/98 and NT

� 32-bit MXChange tools including the Super Project Manager with integrated Tag Editor
for MS Windows 95/98 and NT

� 32-bit MX Interface for MS Windows 95/98 and NT

To install the MXChange software from CD-ROM under MS Windows 95/98, MS Windows
must have been installed properly. To install MXChange under Windows NT you must be
logged in with administrator privileges.

Please close all other running software and installation programs before installing MXChange.

NOTES To install or run MXChange, the following configuration must be installed on your computer,
even if you use the single computer configuration.

� A network card

� TCP/IP Protocol

� MS internet Explorer 3.0 (or higher) for the help files

If your computer does not have a network card, select either the MS Loopback Adapter (MS
Windows NT 4.0) or the Dial-Up Adapter (MS Windows 95/98) in the network configuration
of MS Windows. From the MS Windows Control Panel, select Network Configuration, add
Adapter, select Microsoft, and select Dial-Up Adapter or MS Loopback Adapter.
In very rare cases you must specify an IP address (e.g. 192.168.000.001) for the Dial-Up
Adapter of the computer even if it is not connected to a network. You can specify the IP
address of your computer in the Network Configuration of MS Windows.

In MS Windows 98 in some cases message boxes do not pop-up into the foreground, but
remain hidden behind other opened program windows. This effect is especially
uncomfortable when saving a database by means of the database builder of MX 32 SCADA.
In this case you will not see the pop-up window where you can select Tags for export or
deletion. To get access to the MX 32 SCADA dialog minimize all other program windows.

When many applications are running, it may be that there are not enough system resources
left to start a 16-bit application (like Melsec Medoc plus 2.40a). In this case close any
application which you do not need and try again.

If you change any network setting or install a new network adapter, you have to reboot your
computer before installing or using MXChange.

MXChange will not run reliably on MS Windows NT v4.0 without Service Pack 4 or higher.
The MXChange installation will check for the required Service Pack and return a respective
message box automatically, if the Service Pack is not installed.
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2.3.2 Button functions

You will leave the current menu and enter the next menu.

You will go to the previous menu.

You will abort the installation procedure.

2.3.3 Installing MXChange on your hard disk

The MXChange server, the MXChange tools, and the MX Interface are delivered on one
CD-ROM and are installed by one combined installer. You can select three different setup
types: Typical, compact, and custom.

To start the installation, proceed as follows:

� Start Windows.

� Insert the CD-ROM into your CD-ROM drive.

� Execute the Setup.exe file from the CD-ROM. The Setup.exe file is located in:

MyCDROM:\MXChange\Disk1\Setup.exe

Double-click on the setup.exe file within the Explorer

or

select the Run command from the Windows Start menu and enter the desired path where
"MyCDROM" is the drive letter:

� Follow the instructions guiding you through the installation:
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	 Read the license agreement carefully and follow the instructions given:


 Select the desired installation type. The default setting is Typical. If you choose Typical
or Compact, you will proceed with step �. If you select the Custom setup, you can choose
individually the components to be installed.
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� Click on the checkboxes to deselect or select individual items:

A. Install the MXChange server only

At least one MXChange server installation is compulsory across your TCP/IP network or on
your local computer. The MXChange server provides the connectivity between your
automation development tools.
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B. Install the MXChange tools only

The MXChange tools include the Super Project Manager. By means of the Super Project
Manager you can maintain your common databases.

C. Install the MX Interface only

The MX Interface is only needed for a connection to MX SCADA.

2 – 6 MITSUBISHI ELECTRIC

Software installation Installation

Fig. 2-7:
Select MXChange tools
only

Fig. 2-8:
Select MX Interface
only



� The default destination folder is shown below. For the custom setup the destination location
can be specified individually for the following MXChange components:

a.) Destination Location for Tools (Super Project Manager)

b.) Destination Location for Server
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c.) Destination Location for Server Database

d.) Destination Location for MX Interface


 You can change the destination folder by clicking on the Browse button:
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Destination location for
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Fig. 2-12:
Destination location for
MX Interface

Fig. 2-13:
Choose destination folder



� The default program folders are shown below. You can select another program folder from
the listbox or enter a new program folder into the entry field. For the custom setup the
program folders can be specified individually for the following MXChange components:

a.) Program Folder for MXChange Tools (Super Project Manager)

b.) Program Folder for MXChange Server
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c.) Program Folder for MX Interface

� Now you can read the ReadMe file with the latest information.
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� The MXChange installation is complete. Before you use MXChange you have to restart your
computer. Activate the respective checkbox to restart your computer automatically.

2.3.4 Dongle protection

The software is copy protected via a hardware dongle included in the software package.
Plug the hardware dongle on the parallel port of your personal computer. The signals of the
port are connected through, so you can connect parallel peripherals (e.g. printers) to the
dongle.

Without the dongle connected, MXChange will only run in evaluation mode with the
following restrictions:

� Maximum of 200 tags

� No network capabilities (stand alone system only)

� Only one server instance per computer

The dongle will configure your MXChange version to one of the selected versions:

� 500 tags single computer

� 10000 (unlimited) tags single computer

� 10000 (unlimited) tags networked computer

For the installation you do not need the dongle.
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3 Super Project Manager
The Super Project Manager is the main interface between the user and the MXChange server.
The Super Project Manager is the central tool that lets you manage different automation
projects from just one single common interface.

3.1 Hierarchical structure

The Super Project Manager provides an overview of the complete automation project.
The Super Project Manager provides a hierarchical structure consisting of nodes:

By means of the hierarchical structure you can copy and paste parts of the configuration to
easily generate new MXChange tags from existing tags.
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3.2 Starting the MXChange server

The MXChange server is the central interface between the software tools and the common
database. When the MXChange server is started, it does not require any further setup or
maintenance. The MXChange server must run either on the local personal computer or on a
remote computer accessible via TCP/IP network.

Start the MXChange server from the MS Windows Start/Programs menu (or from where you
installed it):

You can start more than one MXChange server on one single personal computer. Each
MXChange server handles an individual database. The additional MXChange servers are
numbered successively (Server:1, Server:2, ...).

Three MXChange servers running on one single computer:

Click on Stop to suspend the service temporarily and restart it with Start.
Click on Stop & Close to exit the server.
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3.3 Starting the Super Project Manager

Start the Super Project Manager from the MS Windows Start/Programs menu (or from
where you installed it):

3.3.1 Logging in

When starting up or on selecting Log in from the File menu, a dialog box appears
requesting the server name with which to connect, a user name, and password.

The User Name currently cannot be changed and is fixed to Admin.
The default Password is "" (leave it blank).

NOTE The server distinguishes upper-case and lower-case characters within the user name
and password

launches the server browser window. After is selected, the main project
window will be opened with a connection to the given server.
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3.3.2 Server browser

The server browser lists all MXChange servers selectable across the current TCP/IP
network or environment. Select one of these and click .

If there is more than one MXChange server running on one single personal computer,
the additional MXChange servers are numbered successively (Server:1, Server:2, ...).

If there is no MXChange server available, the browser window remains blank. If you have
already entered a server name, user name, and password in the login window, an error
message appears:

In this case start the MXChange server with the required database on your local personal
computer or on a remote one accessible across the TCP/IP network.
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3.4 Using the Super Project Manager

3.4.1 Main project window

When a connection to the server has been established, the main project window is displayed.

The title bar of the window displays "SERVER NAME / COMMON DATABASE NAME".

Click on to expand and on to collapse nodes in the Project Navigator window.

The Tag Editor window is part of the MXChange Tag Editor, which is integrated into the
Super Project Manager. The Tag Editor window displays the MXChange tags and data.

There are separate I/O lists for tags of each base I/O reference type - they are too different to
display in the same list. The separate lists will be selected with “Tab” windows under the list.

When new tags are added, their base type will be that of the currently selected tab.

3.4.2 Refreshing the project window

To update the tree in the main project window, select Refresh from the View menu or
from the toolbar. The tree will also be updated if it is changed by Add node, Delete node,
Modify node, Cut, or Paste.

3.4.3 Logging out

To shut down the connection to the server and to close the main project window for the
connection, select Log out from the File menu.

3.4.4 Closing the application

To close all windows and to shut down the application, select Exit from the File menu.
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3.5 Integrated Tag Editor

The Tag Editor is a table of all tags included in the MXChange database. The tags can be
added, edited, or deleted via the Tag Editor. Additionally, the tags can be added to other
projects or deleted from them.

A tag can be added with several attributes set automatically and with values increasing or
decreasing by different amounts each time it is added.

3.5.1 Main Tag Editor window

The main Tag Editor window lists all tags included in the MXChange database. Each row
contains one tag and the respective MXChange data. Additionally, the row includes a list of
projects to which the tags belong.

3.6 Help

3.6.1 Getting help

Selecting Contents from the Help menu will bring up a browser including online help.

3.6.2 Getting context sensitive help

To get the context sensitive help, press� or select an item via the context sensitive help
cursor. This will bring up a browser including online help. The browser will display the
relevant topic for the item. If no specific help exists for the item, the first online help topic will
be displayed.

3.6.3 About Super Project Manager

To get information on the current version of the Super Project Manager, select About.
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4 Connecting GX IEC Developer

4.1 Integrating a project in MXChange

This chapter describes how to link an existing GX IEC Developer project into the common
database of MXChange.

1. Start the MXChange server

Click on to open the Windows Start menu and select the menu item Programs/
MXChange/MXChange Server.

Start the MXChange server either on your local personal computer or on a different one you
are connected to via the TCP/IP protocol.

Once the MXChange server is running, it does not need any further setup or maintenance.
Therefore, you can minimise it but let it run in the background.
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2. Start the Super Project Manager and login

Click on to open the Windows Start menu and select the menu item Programs/
MXChange/Super Project Manager.

The Login to MXChange server dialog appears automatically:

The User Name cannot be changed and is fixed to Admin.

The default Password is "" (leave it blank).

Confirm by clicking .

NOTE Upper-case and lower-case characters are distinguished by the MXChange server.
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The Super Project Manager establishes the connection to the server.

The Project Navigator window on the left shows all projects connected to MXChange as a
tree of hierarchical nodes.

The Tag Editor window on the right (here still blank) lists all tags of different projects to be
used with MXChange.

3. Open GX IEC Developer project and log on

To connect a GX IEC Developer project to MXChange for the first time, create a
GX IEC Developer project called GETSTART. Refer to the GX IEC Developer
manual for details. Open this project and enable the MXChange support:

For activating the MXChange feature, refer to the manual of your automation software.
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The MXChange server - Log On dialog appears automatically:

Enter MXChange Server, User Name, and Password:

MXChange Server: The TCP/IP address of the personal computer where the
MXChange server is running.
If the server is running locally, click on Use Local Address
for the TCP/IP address of your local personal computer.

The defaults for the user name and password are:

User Name: Admin
Password: "" (leave it blank).

NOTE Upper-case and lower-case characters are distinguished by the MXChange server.

4. Add the GX IEC Developer project to MXChange

As your GX IEC Developer project is connected to the server, MXChange notes that this
project does not exist in the common database and asks whether you want to add it:
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confirm by clicking and the GX IEC Developer project will be added to the Project
Navigator of the Super Project Manager:

5. Tag GX IEC Developer variables for MXChange

Now specify the variable Hello to be included in the common database of
MXChange. Open the GX IEC Developer Global Variable List and click on
the MXChange checkbox of the variable Hello:
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6. Tags are added to MXChange

After the GX IEC Developer variable HELLO has been tagged, save your GX IEC Developer
project to transfer the changes to MXChange. The GX IEC Developer project automatically
inserts an MXChange tag and a GX IEC Developer tag. The view is refreshed by clicking on

in the Super Project Manager.

The first variable name HELLO is included in both, the GX IEC Developer project and the
MXChange tags in the Super Project Manager.

NOTE Any changes you have made in the PLC project within GX IEC Developer are transferred
to MXChange only if you save the PLC project.
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4.2 Open a project from MXChange

GX IEC Developer projects that are included in the MXChange database can be opened in
GX IEC Developer on any Personal Computer connected to MXChange. This way complete
GX IEC Developer projects can be exchanged and backed up easily via a network.

4.2.1 Procedure

1. Log on to MXChange

Start GX IEC Developer and log on to the MXChange server including the project.
In GX IEC Developer either select the menu item Project/MXChange actions/Log on

or

click on the Log on button (for details refer to section 4.1).
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2. Open project from MXChange

In GX IEC Developer either select the menu item Project/MXChange actions/Open

Project from MXChange or click on the according button . These items are available
only, if no project is open.

The following dialog appears listing the appropriate projects.

Select the project to be opened and specify a Local Project Folder where the project will
be stored.

3. Project is opened

The complete project is stored in the specified path and opened in GX IEC Developer.
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5 Connecting GX Developer

5.1 Installation

When installing GX Developer you must have enabled the MXChange Actions to make the
required MXChange functions available in the GX Developer menus.
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5.2 Log in

GX Developer exchanges data with other automation development tools via the MXChange
server. From the menu select Tools/MXChange actions/Log in to log in to the MXChange
server.

The menu selection can only be made, if you have a project opened.

MXChange Server - Login

Make the desired settings and click on the Login button to log in to the MXChange server.

If the log in has been established succesfully, a message box confirms “Login Complete”.
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Item Meaning

Connection

Server Name
Name or IP address of the computer where the MXChange server is started. Enter it
manually, use your local address or select it via the Browse button.

Use Local Address Sets the local computer as the server name
(if GGP/WIN and the MXChange server are executed on the same computer).

Browse Browses the network for connectable MXChange servers. The desired MXChange server
can be selected from a list.

TIme Out Limits the time period for establishing a connection to the MXChange server.
Default:value: 3000 ms; Setting range: 0 to 200000 ms.

Login

User Name Currently cannot be changed. Default: Admin.

Password Password for the MXChange server (1024 characters max.).
Default: “” (leave it blank).

Option

Show Message... Enables/disables an MXChange message box when the GX Developer project data has
been changed in the MXChange database.

Tab. 5-1: Log in dialog items



5.3 MXChange database conversion

The GX Developer project data and the MXChange database exchange information as
described below.

GX Developer

MXChange (Super Project Manager)

In the MXChange database, the device comment types of GX Developer correspond to the
respective GX Developer project nodes (FX project (COMMENT), Q project (MAIN), etc.).

NOTE For the alias name created on GX Developer exported to the MXChange database, only the
following characters are allowed: “A–Z”, “0–9”, “_”.
The alias name must begin with a letter “A–Z”.
The maximum allowed alias name length is 8 characters.

If nothing has been set to the alias of GX Developer at the time of export, the device changes
to tag name.
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Item Project data MXChange database

� Device comment type (COMMENT) GX Developer project node

� Device name Device

� Comment Tag description

� Alias Tag name

Tab. 5-2: Project view items

Fig. 5-4:
MXChange project view

�
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5.4 Export to MXChange tags

The export function writes the device comments and device names created on
GX Developer to the MXChange database.

Export setting

From the menu select Project/Export file/Export to MXChange tags... to open
the Export Setting.
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Fig. 5-5:
Export setting dialog

Item P project data

GX Developer Project:
Data name

Data name of the project name currently edited appears. Select the data name to be
written to the MXChange database from the drop down list.

MXChange:
Project node

Enter a name for the GX Developer project node to be created in the MXChange
database or select an existing GX Developer project node via the browse button.

Tab. 5-3: Export setting dialog items



5.4.1 Export procedure

Click on the Export... button to start the export procedure.

If the GX Developer project node specified in the Export Setting does not exist in the
MXChange database, the following dialog box appears.

Click on the Create button to create a GX Developer project node with the specified name in
the MXChange database.

During the export a dialog box appears indicating the progress of the procedure.

When the export is completed a dialog box appears for confirmation.

NOTE For the alias name created on GX Developer exported to the MXChange database, only the
following characters are allowed: “A–Z”, “0–9”, “_”.
The alias name must begin with a letter “A–Z”.
The maximum allowed alias name length is 8 characters.

If nothing has been set to the alias of GX Developer at the time of export, the device changes
to tag name.
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5.5 Import from MXChange tags

The import function reads GX Developer project data from the MXChange database
into the GX Developer project.

Import setting

From the menu select Project/Import file/Import from MXChange tags... to open
the Import from MXChange tags dialog box.
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Fig. 5-7:
Import setting dialog

Item Meaning

MXChange:
Project node Select an existing GX Developer project node to be imported via the browse button.

GX Developer Project:
Data name

From the drop down list select the data name in the currently opened GX Developer
project to be imported to.

Tab. 5-4: Import setting dialog items



5.5.1 Import procedure

Click on the Import... button to start the import procedure.

The import deletes all existing comment data in the GX Developer project and reads all
comment data of the specified project node from the MXChange database.

If the PLC type set for the selected GX Developer project node differs from the PLC type of
the GX Developer project to be imported to, only the data within the PLC type range of the
GX Developer project is imported.

During the import a dialog box appears indicating the progress of the procedure.

When the import is completed a dialog box appears for confirmation.

NOTE When importing an MXChange tag into the GX Developer project, only the first 8 characters of
the tag name (64 characters max.) are read into the GX Developer alias (8 characters max.).

When importing an MXChange tag into the GX Developer project, only the first
32 characters of the tag description (64 characters max.) are read into the GX Developer
comment (32 characters max.).
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6 Connecting MX32
Via MXChange MX tags can be exchanged with other automation software packages.

6.1 Starting MXChange

Start the MXChange server on your local personal computer or on a different personal
computer you can connect to via TCP/IP (for details refer to section 3.2).

Start the Super Project Manager and login to the MXChange server (for details refer to
section 3.3).

Here the automation project starts showing two PLC projects, GETSTART from GX IEC
Developer (for details refer to section 4) and RSE01 from GX Developer (for details refer
to section 5).
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6.2 Starting MX32

Start MX32 from the MS Windows Start menu:
Start/Programs/Mitsubishi MX/Startup.

Start MX Interface from the MS Windows Start menu:
Start/Programs/MXChange/MX Interface and login to the MXChange server:

Select the personal computer the MXChange server is running on via the Browse button.
The User Name is fixed to Admin. Either leave the Password entry blank or enter the valid
password for the MXChange database, if you have specified one.

As you connect your MX32 project to MXChange for the first time it can not be found on the
MXChange server. The following dialog appears:

Click Yes to create an MX32 project node in the MXChange database.

The following dialog appears:

Click Yes to activate online changes.
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Creating a new project node in MXChange

Fig. 6-4:
Enabling online changes



The MXChange Interface main window appears listing all events:

Now MX32 is connected to the MXChange server.

Your MX32 project has automatically been added to the MXChange database. It is
represented as node in the Automation project navigator of the Super Project Manager.
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6.3 Specifying the I/O drivers in MXChange

You have to specify the communications path between MX32, an assigned PLC project, and
MXChange.

NOTE If you intend to connect a PLC project and an MX SCADA project, ensure that the I/O card of
the PLC project corresponds to the MX driver and the respective channel and device of the
MX32 project. The driver, channel, and device of the MX32 project node must be added
manually to MXChange.
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6.3.1 MX32 project node

MCS driver

For e. g. Ethernet communications via the MX32 MCS driver you need to add the following
nodes to MXChange:

1. A driver node and a device node to the MX32 project node.

2. A TCP/IP card node to the assigned PLC project node.

The settings of these nodes must match with the settings of the MX32 MCS driver.

The MCS driver in MX32 has to be already installed and configured correctly (for details
refer to the MX32 documentation). Open the MX32 System Configuration and check the
MCS driver settings.
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� Add a new MCS driver node to the MX32 project node

To add a new MCS driver node to the MX32 project node:

� Right-click on the MX32 project node.
The context menu opens.

� Select Add Node.
The Select node type dialog appears.

Select the MCS driver and confirm by clicking :

Enter node specific information

The following dialog box appears:

Enter a driver name and confirm by clicking .

The MCS driver is created under the MX32 project node . It is represented as node in the
Automation project navigator of the Super Project Manager.
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� Add a new MCS device node to the MCS driver node

To add a new MCS device node to MCS driver node:

� Right-click on the MCS driver node.
The context menu opens.

� Select Add Node.
The dialog Adding "MCS device" appears:

� Look up the settings of the MX32 MCS driver in the MX32 System Configuration.

Enter the node specific information. Confirm by clicking .

The MCS device is created under the MCS driver node . It is represented as node in the
Automation project navigator of the Super Project Manager.
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MCS device specification

Item Meaning

Name � Device name (included in the I/O record)

Channel no. � Number of the used channel

PC side interface � Connection of the personal computer running MX32 to the PLC

Description User definable description for the device

Connected PLC Connected PLC project from the MXChange database

Tab. 6-1: MCS device specification items

Fig. 6-11:
New driver and device node in MXChange



MQE driver

For Ethernet communications via the MX32 MQE driver you need to add the following nodes
to MXChange:

1. A driver node, a channel node, and a device node to the MX32 project node.

2. A TCP/IP card node to the assigned PLC project node.

The settings of these nodes must match with the settings of the MX32 MQE driver.

The MQE driver in MX32 has to be already installed and configured correctly (for details
refer to the MX32 documentation). Open the MX32 System Configuration and check the
MQE driver settings.
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� Add a new MQE driver node to the MX32 project node

To add a new MQE driver node to the MX32 project node:

� Right-click on the MX32 project node.
The context menu opens.

� Select Add Node.
The Select node type dialog appears.

Select the MQE driver and confirm by clicking :

Enter node specific information

The following dialog box appears:

Enter a driver name and confirm by clicking .

The MQE driver is created under the MX32 project node. It is represented as node in the
Automation project navigator of the Super Project Manager.
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� Add a new MQE channel node to the MQE driver node

To add a new MQE channel node to the MQE driver node:

� Right-click on the MQE driver node.
The context menu opens.

� Select Add Node.
The dialog Adding "MQE channel" appears.

Enter the node specific information and confirm by clicking .

The MQE channel is created under the MQE driver node. It is represented as node in the
Automation project navigator of the Super Project Manager.
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� Add a new MQE device node to the MQE channel node

To add a new MQE device node to the MQE channel node:

� Right-click on the MQE channel node.
The context menu opens.

� Select Add Node.
The dialog Adding "MQE device" appears.

All settings must match with the according I/O driver configuration in MX32. Look up the
settings of the MX32 MCS driver in the MX32 System Configuration.

Enter the node specific information. The CPU type, protocol, card type, network number,
and poll type can be selected from drop-down lists. Confirm by clicking .
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Item Meaning

Name Device name (included in the I/O record)

Description Device description

CPU type Type of CPU to which the device is connected

Protocol Protocol to use

TCP/IP address Primary TCP/IP address to which the driver is connected

TCP/IP port TCP/IP port at the primary address

PLC address PLC address to which the driver is connected (0-64: slave, 255: master)

Card type I/O card type in the PLC

Network number Network number (0-239)

Poll type Poll type (polled or unsolicited)

Tab. 6-2: Adding MQE device dialog items

Fig. 6-16:
Adding an MQE device



The MQE device is created under the MQE channel node. It is represented as node in the
Automation project navigator of the Super Project Manager.
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MFX driver

For serial communications via the MX32 MFX driver you need to add the following nodes
to MXChange:

1. A driver node, a channel node, and a device node to the MX32 project node.

2. A serial card node to the assigned PLC project node.

The settings of these nodes must match with the settings of the MX32 MFX driver.

The MFX driver in MX32 has to be already installed and configured correctly (for details
refer to the MX32 documentation). Open the MX32 System Configuration and check the
MFX driver settings.
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� Add a new MFX driver node to the MX32 project node

To add a new MFX driver node to the MX32 project node:

� Right-click on the MX32 project node.
The context menu opens.

� Select Add Node.
The Select node type dialog appears

Select the MFX driver and confirm by clicking :

Enter node specific information

The following dialog box appears:

Enter a driver name and confirm by clicking .

The MFX driver is created under the MX32 project node. It is represented as node in the
Automation project navigator of the Super Project Manager.
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Fig. 6-19:
Node type selection

Fig. 6-20:
Entering an MFX driver node name



� Add a new MFX channel node to the MFX driver node

To add a new MFX channel node to the MFX driver node:

� Right-click on the MFX driver node.
The context menu opens.

� Select Add Node.
The dialog Adding "MFX channel" appears.

All settings must match with the according I/O driver configuration in MX32. Look up the
settings of the MX32 MCS driver in the MX32 System Configuration.

Enter the node specific information and confirm by clicking .

The MFX channel is created under the MFX driver node. It is represented as node in the
Automation project navigator of the Super Project Manager.
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� Add a new MFX device node to the MFX channel node

To add a new MFX device node to the MFX channel node:

� Right-click on the MFX channel node.
The context menu opens.

� Select Add Node.
The dialog Adding "MFX device" appears.

� Look up the settings of the MX32 MFX driver in the MX32 System Configuration.

Enter the node specific information and confirm by clicking .

The MFX device is created under the MFX channel node. It is represented as node in the
Automation project navigator of the Super Project Manager.
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Fig. 6-22:
Adding an MFX device

Item Meaning

Name � Device name (included in the I/O record)

Description Device description

Connected PLC PLC project to which the device is connected

Tab. 6-3: Adding an MFX device dialog items

Fig. 6-23:
New MFX driver, channel, and device in MXChange



6.3.2 PLC project node

TCP/IP card

For Ethernet communications via the MX32 MCS and MQE drivers you need to add a
TCP/IP card node to the PLC project node MX32 is assigned to.

The settings of the TCP/IP card node must match with the settings of the MX32 drivers
specified in the MX32 System Configuration.

� Add a new TCP/IP card node to the PLC project node

To add a new TCP/IP card node to the PLC project node (GETSTART):

� Right-click on the PLC project.
The context menu opens.

� Select Add Node.
The Select node type dialog appears.

Select the TCP/IP card and confirm by clicking :
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� Enter node specific information

The following dialog box appears:

Enter the node specific information and confirm by clicking .

The TCP/IP address and the Port no. must match with the according I/O driver
configuration in MX32. Look up the settings of the MX32 driver in the MX32 System
Configuration.

The TCP/IP card is created under the PLC project node (GETSTART). It is represented as
node in the Automation project navigator of the Super Project Manager.
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Fig. 6-25:
Adding a TCP/IP card

Fig. 6-26:
New TCP/IP card node in MXChange



Serial card

For serial communications via the MX32 MFX driver you need to add a serial card node to
the PLC project node MX32 is assigned to.

The settings of the serial card node must match with the settings of the MX32 drivers
specified in the MX32 System Configuration.

� Add a new serial card node to the PLC project node

To add a new serial card node to the PLC project node (RSE01(COMMENT)):

� Right-click on the PLC project.
The context menu opens.

� Select Add Node.
The Select node type dialog appears.

Select the serial card and confirm by clicking :
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� Enter node specific information

The following dialog box appears:

Enter the node specific information and confirm by clicking .

The serial card is created under the PLC project node (RSE01(COMMENT)). It is
represented as node in the Automation project navigator of the Super Project Manager.
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Fig. 6-28:
Adding a serial card node

Fig. 6-29:
New TCP/IP card node in MXChange



6.4 Adding tags to MXChange

Tags that are included in the MX database can be exported to MXChange. Open the MX32
Database Builder and open the database. In our example six tags are already included.
Note, that the I/O device (MCS, MFX, MQE) and the I/O address (MXdev1..., D11..., M11...)
of the tags must match with the MXChange settings.

In the MXChange Interface window click Export tags.
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The following dialog box appears:

Select the tags to be exported to MXChange. Several tags can be selected individually by
clicking them in combination with the [CTRL] or [SHIFT] keys.

Confirm your selection with OK.

The following message box appears:

Only when you save the database in the MX32 Database Builder the tags are exported and
updated in MXChange.

Confirm with OK.
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Fig. 6-32: Tag selection for export

Fig. 6-33:
Export message



In the Database Builder save the database.

The following dialog appears:

Select to which project nodes in MXChange each tag is to be added.

Note, that each tag can be added to only one PLC project. Note, that tags can be added
only to PLC projects you specified the communication path for. Adding tags to other PLC
projects would fail.

Confirm your selection with OK.

The MXChange Interface lists all events and confirms adding the selected tags.
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Fig. 6-34:
Project selection for export

Fig. 6-35: MXChange Interface



The tags being added to MXChange are listed in the Super Project Mananger:

If the tags are changed in MX32, they are also updated in MXChange whenever the MX32
database is saved.
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7 Connecting MX2000
The principles of connecting MX2000 are exactly the same as for MX32. For details refer to
section 6.

� Start the MXChange server on your local personal computer or on a different personal
computer you can connect to via TCP/IP (for details refer to section 3.2).

� Start the Super Project Manager and login to the MXChange server (for details refer to
section 3.3).

� Start MX2000 from the MS Windows Start menu:
Start/Programs/Mitsubishi MX/Startup.

� Start MX Interface from the MS Windows Start menu:
Start/Programs/MXChange/MX Interface and login to the MXChange server.

	 As you connect your MX2000 project to MXChange for the first time it can not be found on
the MXChange server. Confirm all following dialogs to to create an MX2000 project node in
the MXChange database.


 Specify the I/O drivers in MXChange. You have to specify the communications path
between MX2000, an assigned PLC project, and MXChange.

For e. g. Ethernet communications via the MX2000 MCS driver you need to add the
following nodes to MXChange:

1. A driver node and a device node to the MX2000 project node.

2. A TCP/IP card node to the assigned PLC project node.

The settings of these nodes must match with the settings of the MX2000 MCS driver.
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Fig. 7-1:
MCS driver and device node



7.1 Adding tags to MXChange

Tags that are included in the MX database can be exported to MXChange. Open the
MX2000 Database Manager and open the database. In our example three tags are already
included. Note, that the I/O device (MCS) and the I/O address (MXdev1) of the tags must
match with the MXChange settings.

� In the MXChange Interface window click Export tags.

� Select the tags to be exported to MXChange.

� In the Database Builder save the database.

� Select to which project nodes in MXChange each tag is to be added.

	 The MXChange Interface lists all events and confirms adding the selected tags.
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Fig. 7-2: MX2000 Database Manager

Fig. 7-3: MXChange Interface




 The tags being added to MXChange are listed in the in the Super Project Mananger:

If the tags are changed in MX2000 they are also updated in MXChange whenever the
MX2000 database is saved.
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8 Connecting E-Designer
Via MXChange I/O references of other automation software packages can be used in the
I/O browser of E-Designer.

8.1 Starting MXChange

Start the MXChange server on your local personal computer or on a different personal
computer you can connect to via TCP/IP (for details refer to section 3.2).

Start the Super Project Manager and login to the MXChange server (for details refer to
section 3.3).

Here the automation project starts showing two PLC projects, GX IEC Developer (for details
refer to section 4) and GX Developer (for details refer to section 5). Two MX projects
assigned to the PLC projects are included either.
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Fig. 8-1:
Initial automation project



8.2 Configuring E-Designer

1. Start E-Designer

Start E-Designer from the MS Windows Start menu:
Start/Programs/E-Designer/E-Designer.

2. Open Project

Open the E-Designer project you want to connect to MXChange.

3. Select MELSEC I/O naming

From the main menu select File/MELSEC I/O Naming. The following dialog appears where
you select the source for the I/O naming in the I/O browser.

Select MXChange and click the Configure button.
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Fig. 8-2: Opened E-Designer project

Fig. 8-3:
MELSEC I/O naming



4. Configure MXChange connection

The following dialog appears where you specify the connection to the MXChange server.

Specify the Server name of the personal computer the MXChange server is running on.
Either click the Browse button to browse for it across the network or select Local
connection for your local personal computer.

Enter “Admin” for the user name. Leave the Password blank. These entries are fixed and
will be implemented in future versions.

Confirm by clicking OK.

5. Select project

The following dialog appears where you would select the MXChange project node to
connect to. For this first connection there is no project included yet.

Click the New button to create a new project node to MXChange.
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Fig. 8-4:
MXChange configuration

Fig. 8-5: Project selection



6. Create new project node

The following dialog appears where you specify the new project node.

Enter the project name and the project path of your E-Designer project.

Select a PLC project node from the drop down list. The PLC project node already must have
been created by GX IEC Developer (refer to section 4) or GX Developer (refer to section 5).

Confirm by clicking OK.

7. Select project

The following dialog appears now including the new E-Designer project node in MXChange.

Confirm by clicking OK to leave the configuration of the connection.
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Fig. 8-6: Project creation

Fig. 8-7: Project selection



8. Select MELSEC I/O Naming

The following dialog appears where you connect to MXChange.

Confirm by clicking OK.

9. Project node created

In the Automation project navigator of the MXChange Super Project Manager your
E-Designer project node (HMI-getstart) has been created together with a PLC connection
to the PLC project (GETSTART).
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Fig. 8-8:
MELSEC I/O naming

Fig. 8-9 :
New E-Designer project node in MXChange



8.2.1 Adding tags to the E-Designer project node

There are several ways to add tags to a project node.

a) Adding tags in the Tag Editor

One easy way is to right-click on the tag in the Tag Editor of the MXChange Super Project
Manager to open the context menu. Select Add MXChange Tag to Project and in the sub
menu the desired E-Designer project to add the tag.

b) Adding tags in the Automation project navigator

In the Automation project navigator of the MXChange Super Project Manager the tags
can also be dragged from the expanded PLC project node (GETSTART) and dropped on
the PLC Connection of the E-Designer project node.

c) Adding tags by automation software

The tags can also be added to the E-Designer project node by the other automation
software packages, e. g. MX 32 (refer to section 6.4).
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Adding tags to project

Fig. 8-11:
Adding tags to project



8.2.2 Tags available in I/O Browser

All tags that are added to the E-Designer project node can be selected within E-Designer
from the I/O browser. The I/O browser is available from many menus via the I/O button.
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A Appendix

A.1 Toolbar items
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Appendix Toolbar items

Item Description

Login

Logout

New database

Open database

Save database as

Change password

Change preferences

Add node

Refresh view

New window

Cascade windows

Tile windows vertically

Tile windows horizontally

Context sensitive help

About box

Tab. A-1: Toolbar items
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